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Introduction

U.S. Department of Labor
Employment Standards Administration
Office of Labor-Management Standards

 

Welcome to the Electronic Form LM-3
 

The U.S. Department of Labor’s Office of Labor-Management Standards (OLMS) is pleased to 
introduce the new electronic Form LM-3. You can now complete your union’s Form LM-3 quickly 
and easily using your computer and this software.

Why should you choose to complete your union’s Form LM-3 electronically, rather than 
manually on paper? There are several advantages to using this new electronic version:

●     It’s easy to enter information on the form.
●     You can download some information from the OLMS Website and load it directly onto the 

form.
●     The system performs calculations for you, so you won't make mathematical errors.
●     Before your officers sign the form, the system checks for errors and discrepancies and 

allows you to correct or explain them, reducing the likelihood of having to file an 
amended report.

Your union's president and treasurer can sign the electronic form using easily obtainable digital 
signatures and submit it to OLMS over the Internet. Alternatively, you can print a paper copy 
of the form, have your union’s president and treasurer sign it manually, and mail it to OLMS.

We encourage you to use the electronic Form LM-3 instead of the paper form. It will make 
filing your union’s Form LM-3, quicker, easier, and more accurate.
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Starting the Electronic Form LM-3

Starting the Electronic Form LM-3

The installation process for the electronic Forms LM-2, LM-3, and LM-4 places an icon for 
starting the program on your desktop.

Note: The first time that you use the electronic forms 
program, a dialog box displays, giving you an option to enter 
a registration number for licensing. Do not enter anything in 
that box, but simply click the "Use Form Now" button. The 
form templates have been fully licensed by OLMS for use in 
the Shana Filler application and, therefore, no separate 
registration is required. The registration option does not 
display after the first use.

Creating a new Form LM-3

Double-click on the electronic forms icon. A list of available Informed templates displays. 
Select "LM-3 Form" and click the "New" button.

The first page of the electronic Form LM-3 displays. Consult the table of contents of this 
User Guide for detailed instructions for the various features of electronic Form LM-3 
software. 
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Starting the Electronic Form LM-3

Note to Windows XP Users: If an error occurs when you try to open a new form LM-2, 
LM-3, or LM-4, contact your System Administrator to modify the folder-level user 
permissions for the C:\Informed directory:

Right-click on the Informed folder and select "Properties." Click on the "Security" tab and 
allow the user to have full control to the Folder. Click the "Advanced" button and make 
sure that the user is selected and both permission options at the bottom of the screen are 
checked.

If you continue to have problems, contact the Help Desk at 1-866-319-2675.

Save your file!
As you complete your Form LM-3, remember to save your file 
often. When you select "Save" or "Save As" from the "File" 
menu, the system adds the extension ".ifm" to your file name.

Opening an existing Form LM-3

Double-click on the electronic forms icon to start the program. A list of available Informed 
templates displays. Click the "Cancel" button.

Select "Open" from the "File" menu on the menu bar. 

A file box displays. Navigate to the drive and directory where your saved file is located and 
highlight the file name in the list. Click the "Open" button.
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Starting the Electronic Form LM-3

Alternatively, you can select your file from a list of recently used forms. From the "File" 
menu, select "Recent Data Documents." The names of recently used files display. Click the 
appropriate file name.
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A Look at the Electronic Form LM-3

A Look at the Electronic Form LM-3

When you start the electronic Form LM-3, the form displays on the screen ready for data entry. 
Because the electronic Form LM-3 looks almost identical to the paper form, users who have 
completed the paper form in the past will be familiar with the arrangement of items on the 
electronic form.

System requirements

You must have an Internet browser (Internet Explorer or Netscape version 4.x or above) 
installed on your computer to complete the electronic Form LM-3. To use the pre-fill data 
feature of the system, you must be connected to the Internet. For detailed information on 
system requirements, start the electronic Form LM-3 and select "User Information" from the 
"Form Instructions" menu on the menu bar, then select "System Requirements."

On-screen features

The electronic Form LM-3 has a number of on-screen features to help you move through the 
form and enter information.
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A Look at the Electronic Form LM-3

●     Yellow buttons - Click the yellow buttons appearing on the form to perform the action 
displayed on the button -- move to an item or location, add or delete pages, or obtain 
further information about the electronic Form LM-3. 

●     White arrows - Click the white arrows to move forward to the next page or back to a 
previous page in Item 56, Additional Information.

●     Drop-down lists – Complete certain items by making selections from drop-down lists. 
See Completing the Form in this User Guide.

●     Page tabs – Move back and forth through the pages by selecting one of the "tabs" 
displayed at the top of each page. See Moving Through the Form in this User Guide.

●     Pop-up boxes - Dialog boxes will automatically display during the course of completing 
the form to help you enter data for certain items, warn you of potential errors, or 
request additional information where required.
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A Look at the Electronic Form LM-3

●     Pre-fill data – Retrieve data from your union’s latest report filed with OLMS for 
automatic entry of information in Item 2 (Period Covered); Items 4 through 7 (union 
identification); Item 8 (Mailing Address); and Columns A and C, Items 25 through 36 
(financial information). See Using Pre-Fill Data in this User Guide.

●     Initial zeros in Items 24 – 55 - When you first open the electronic Form LM-3, the 
financial items 24 through 55 display "0" in each item. See Financial Items 24 – 55 in 
this User Guide.

●     Automatic calculations - The electronic Form LM-3 automatically performs all 
mathematical calculations required in Item 24 and Statements A and B. See Financial 
Items 24 – 55 in this User Guide.

Informed Filler features

The electronic Form LM-3 runs within Shana’s Informed Filler Version 3.0. The components of 
Informed Filler required to operate the electronic form are automatically loaded on your 
computer during the installation process. Some features of Informed Filler which may be useful 
in completing the Form LM-3 include:

●     Place note – You can attach notes or comments to your form. A note looks like a small 
piece of yellow paper. 

To place a note on your form, select "Place Note" from the "Edit" menu on the menu 
bar.
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A Look at the Electronic Form LM-3

A small yellow note displays in the center of your form window and can be placed 
anywhere on the form.

To enter, view, or change text in the note, click in the text box at the right side of the 
note. The "Note" dialog box displays. Enter or edit your message then click the "OK" 
button. 

To delete the note, click on the note. This changes the box from yellow to blue. Press 
the "Delete" key.

●     Cell memorize – This command memorizes the current entry in an item or cell. When 
you open a new form, the memorized value displays in the same item or cell. 

To memorize a value, select the value in the item or cell. Select "Memorize" from the 
"Cell" menu on the menu bar.

To remove the memorized value from the item or cell, memorize a blank value.

Save your file! As you complete your Form LM-3, remember 
to save your file often. When you select "Save" or "Save As" 
from the "File" menu, the system adds the extension ".ifm" to 
your file name.

 

8



Moving Through the Form

Moving Through the Form

Moving from item to item

To move the cursor from item to item (or to separate fields within an item), press the <Tab> 
key. This is the preferred method for moving through the form. By using the <Tab> key, you 
are assured of moving to the next sequential item or field on the form. 

After you enter data in a particular item, press the <Tab> key. The data is automatically 
formatted and the cursor moves to the next item.

To return to a previous item, press the <Shift> and <Tab> keys at the same time. 

Moving from page to page

●     <Tab> key - After you complete the last item on a page, press the <Tab> key to move 
to the first item on the next page. 

●     Page tabs – Move back and forth through the pages by selecting one of the six "tabs" 
displayed at the top of each page.

●     Goto menu - Select the desired page from the "Goto" menu on the menu bar.
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Labor Organization File Number - Item 1

Labor Organization File Number - Item 1

In Item 1, you must enter the 6-digit file number which OLMS assigned to your union. Once 
you enter the file number in Item 1, the system automatically enters it at the top of pages 2 
through 4, the Item 24 continuation page, and all Item 56, Additional Information pages. If 
you do not know your union’s file number, you can obtain it from the following sources.

Prior reports

Review your union’s copies of reports submitted to OLMS in prior years.

Mailing label

If the Form LM-3 was mailed to you with an address label, your union’s file number is the 6-
digit number printed on the first line of the label.

OLMS Website

Search the OLMS Website to find your union's file number. After first connecting to the 
Internet, you may access the OLMS Website directly from the electronic Form LM-3.

Select "OLMS Website" from the "Goto" menu on the menu bar.

The OLMS Website displays in your browser.

Go to the LMRDA Reporting & Public Disclosure section on this site and follow instructions 
for searching for a union by affiliation or organization name.
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Labor Organization File Number - Item 1

To reach the OLMS Website outside the electronic Form LM-3, go to:

http://www.dol.gov/esa/olms_org.htm

OLMS field offices

Contact the nearest OLMS field office to obtain your union’s file number. You can access the list 
of OLMS field offices within the electronic Form LM-3 by selecting "LM-3 Instructions" from the 
"Form Instructions" menu on the menu bar and then selecting "If You Need Assistance" from 
the Table of Contents.

You can also go to the OLMS Website (see above instructions) for the addresses and telephone 
numbers of OLMS field offices. 
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Using Pre-Fill Data

Using Pre-Fill Data

You can save time and ensure the accuracy of your union’s identification, mailing, and prior 
year financial information entered on Form LM-3 by retrieving the pre-fill data from your 
union’s latest report filed with OLMS. You must first be connected to the Internet to access and 
retrieve your union’s pre-fill information.

In Item 1, enter your union’s file number and press the <Tab> key. 

Note: If you do not know your union’s file number, see Labor 
Organization File Number – Item 1 in this User Guide.

Click the yellow "Get Pre-fill Data" button.

The system displays a dialog box reminding you that you must be connected to the 
Internet.

Click the "OK" button.

The system displays a dialog box asking you to enter the fiscal year of the report you are 
completing.

Enter the fiscal year in a 4-digit format, for example, 2000, and click the "OK" button.

12



Using Pre-Fill Data

The three types of pre-fill information on file with OLMS display.

Identification Information

Review the Identification Information section of the pre-fill display.

If it is correct, click the "Approve" check box in the upper left corner to have this 
information automatically entered on the report you are completing. 
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Using Pre-Fill Data

If the information is not correct, you may make corrections by clicking in the appropriate 
field and entering the correct information. After you have made all corrections, click the 
"Approve" check box.

Mailing Information

Scroll down to view the Mailing Information section of the pre-fill display.

If it is correct, click the "Approve" check box in the upper left corner to have this 
information automatically entered on the report you are completing. 

If the information is not correct, you may make corrections by clicking in the appropriate 
field and entering the correct information. After you have made all corrections, click the 
"Approve" check box.

Financial Information (Start of Reporting Period)

Scroll down to view the Financial Information section of the pre-fill display. The amounts 
displayed are from your union’s prior year report for the end of the reporting period. The 
amounts reported in Items 25 through 36 in Statement A, Columns B and D last year 
should be reported in Columns A and C, start of the reporting period, for the same items 
on the report you are completing. 

If it is correct, click the "Approve" check box in the upper left corner to have this 
information automatically entered on the report you are completing. 
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Using Pre-Fill Data

If the information is not correct, you may make corrections by clicking in the appropriate 
field and entering the correct information. You must also explain in Item 56, Additional 
Information, why the amounts differ from your union’s prior year report. See Additional 
Information – Item 56 in this User Guide.

After you have made all corrections, click the "Approve" check box.

Note: If for any reason you do not wish to use the pre-fill 
data, click the "No" button at the bottom of the pre-fill display 
to return to the form. No data will be transferred to the Form 
LM-3 you are completing.

Click the "Yes" button at the bottom of the display to transfer the approved data to the 
report you are completing.

The system returns to the form which now displays all approved data for Item 2 (Period 
Covered), Items 4 through 7 (union identification), and Item 8 (Mailing Address) on page 1 
of your union’s Form LM-3. The yellow "Get Pre-fill Data" button is no longer active.
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Using Pre-Fill Data

Reminder: After returning to page 1 of the form, complete 
Item 3, if appropriate, and Item 9 before moving to page 2.

Page 4 of the form displays approved data for Statement A, Columns A and C (Items 25 
through 36.)

After retrieving pre-fill data, save your form.

Note: If you want to use the import feature for completing 
Item 24, you should import your data after retrieving pre-fill 
data and before completing other items. See Importing Data 
into Item 24 in this User Guide. 
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Completing the Form

Completing the Form

There are several ways to enter information on the electronic Form LM-3:

●     retrieving pre-fill data from OLMS
●     importing data from existing files
●     using text or numbers
●     checking boxes
●     selecting from drop-down lists

Pre-fill data

You can retrieve your union’s identification, mailing, and prior year financial information from 
OLMS via the Internet. See Using Pre-Fill Data in this User Guide.

Importing data into Item 24

You can import data from your computer records using a specially formatted text file to 
complete Item 24, All Officers and Disbursements to Officers. See Importing Data into Item 24 
in this User Guide.

Note: If you use the pre-fill data and/or import data features, 
you should complete these processes before completing other 
items. First, retrieve pre-fill data and save your form. Next, 
import data into Item 24 and save your form.

Entering financial information 

When entering numbers for requested financial information, use whole dollars only –
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Completing the Form

DO NOT ENTER: 

●     cents
●     decimal points
●     commas
●     dollar signs

Automatic calculations

The electronic Form LM-3 automatically performs all mathematical calculations required in Item 
24 and Statements A and B. See Financial Items 24 – 55 in this User Guide.

Checkboxes

Some items on the form are answered by simply making an entry in a checkbox. For example, 
complete Items 9 through 18 and Item 21 by making an entry in either the "Yes" or "No" 
checkbox.

Press the <Tab> key to move to the appropriate checkbox which becomes highlighted. 
Press any key to enter an "X" in the selected box. To uncheck the box, press any key while 
in the selected box.

You can also click in the appropriate checkbox to both select it and enter an "X."

Depending on your answer to certain items, you may be prompted to provide additional 
information in Item 56. See Additional Information – Item 56 in this User Guide.

Drop-down lists

When you move to an item having a drop-down list, the list automatically displays.
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Completing the Form

Move through the choices on the list by using the scroll bar or entering the first letters of 
your selection. Make your selection by double-clicking on the appropriate choice.

Your selection displays in that item and the cursor moves to the next item.

If your union is affiliated with a national or international union and you are not using pre-
fill data, you must select your entries for Item 4, Affiliation or Organization Name, and 
Item 5, Designation, from the drop-down lists. See Union Identification – Items 4 – 7 in 
this User Guide.
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Amended, Terminal, or Subsidiary Reports – Item 3

Amended, Terminal, or Subsidiary Reports – Item 3

Answer Item 3 only if the report you are completing is an amended report, a terminal report, 
or a separate report for a subsidiary organization. 

●     An amended report is filed to correct a report previously filed by your union. 

●     A terminal report is filed if your union goes out of existence by disbanding or merging 
into another union.

●     A report for a subsidiary organization is a separate Form LM-3 reporting only the 
financial information for a subsidiary organization, such as a building corporation wholly 
owned by your union. This report is filed with the union’s Form LM-3.

Note: A separate Form LM-3 for a subsidiary organization 
cannot be filed electronically but must be printed, signed 
manually, and mailed to OLMS.

If none of these conditions apply to the report you are completing, leave Item 3 blank.
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Union Identification Information – Items 4 - 7

Union Identification – Items 4 - 7

If you are connected to the Internet, you can use the pre-fill data feature to retrieve data from 
your union’s latest report filed with OLMS and automatically enter information in Items 4 
through 7 (union identification), as well as in Item 2 (Period Covered) and Item 8 (Mailing 
Address). See Using Pre-Fill Data in this User Guide. If you do not use pre-fill data, you must 
enter your union’s identification information in Items 4 through 7, as appropriate.

Affiliation or Organization Name 

When you move to Item 4, Affiliation or Organization Name, the drop-down list of all affiliated 
unions displays.

Affiliated unions

If your union is affiliated with a national or international union, you must use the displayed 
drop-down lists for entries in Items 4 and 5 to ensure proper completion and accuracy.

●     Item 4 - Affiliation or Organization Name - Select your union’s affiliation name from 
the drop-down list. Move through the choices on the list by using the scroll bar or 
entering the first letters of your union’s affiliation. To select an affiliation, double-click 
the appropriate choice. 

Your selection displays in Item 4 and the cursor moves to Item 5.
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Union Identification Information – Items 4 - 7

Note: The Item 4 drop-down list contains the commonly used 
names or "short titles" of all union affiliations in the OLMS 
database. The first name in the short title is based on the 
keyword in the union’s name. For example, "Engineers" is the 
keyword for Operating Engineers. This union would be found 
in the list under "e" as "Engineers, Operating." If you cannot 
initially find your union affiliation name, try another affiliation 
keyword for your union.

●     Item 5 - Designation Name – When you move to Item 5, a drop-down list of all union 
designation names displays. 

Move through the choices on the list by using the scroll bar or entering the first letters of 
your union’s designation name. To select a name, double-click the appropriate choice. 
Your selection displays in Item 5 and the cursor moves to Item 6.

The designation name for a national or international union is "National Headquarters 
(NHQ)."

●     Item 6 – Designation Number – When you move to Item 6, a dialog box displays 
informing you that Item 6, Designation Number, includes space for a core designation 
number and that space is also provided to add a prefix or a suffix, if needed. Click the 
"OK" button.
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Union Identification Information – Items 4 - 7

The Item 6 data entry field is divided into 3 sections to display a prefix, the core 
designation number, and a suffix. The cursor first moves to the core designation number 
section. 

Enter your union’s core designation number in this middle section and press the <Tab> 
key. For example if your union’s designation name and number is LU 277, enter "277."

The number displays in the middle section and the cursor moves to the section in front 
of the core number to add a prefix. Enter the prefix for your union’s designation number, 
if any, and press the <Tab> key to move to the suffix section. Enter the suffix, if any, 
and press the <Tab> key to move to Item 7.

Note: The majority of affiliated unions have only a core 
designation number. If your union’s designation number has 
no prefix or suffix, just press the <Tab> key twice after 
entering the core number to move to Item 7.

●     Item 7 – Unit Name – If your union has any additional or alternate name by which it is 
known, such as "Chicago Area Local," enter the name in Item 7. 

Unaffiliated unions

If your union is not affiliated with a national or international union, ignore the drop-down list 
and complete Item 4 and Item 7 (if appropriate).

●     Item 4 – Affiliation or Organization Name – Enter your union’s name in Item 4. 
Names of affiliated unions may display in Item 4 as you enter your union’s name. Just 
continue typing until you complete the name and press the <Tab> key. Your union’s 
name is automatically formatted in all upper case letters in Item 4.

Because unaffiliated unions will not have entries in Items 5, Designation, and Item 6, 
Designation Number, the cursor moves to Item 7, Unit Name (if any). 

●     Item 7 – Unit Name – If your union has any additional or alternate name by which it is 
known, such as "Chicago Area Local," enter the name in Item 7. 
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Financial Items 24 - 55

Financial Items 24 - 55

Initial zeros in Items 24 - 55

When you first open the electronic Form LM-3, a zero (0) displays in Item 24, Lines 10 and 11 
(page 3) and in Items 25 through 55 (page 4). Because the instructions for the form require 
that you complete each of these items and enter "0" where appropriate, you only need to 
complete the financial items that require an entry other than "0." 

When you move to an item with an initial zero: 

●     If there is financial data to report and the correct entry is not "0," enter the correct 
amount for the item and press the <Tab> key. The "0" is replaced with the number you 
enter. 

●     If there is no financial data to report and the correct entry is "0," just press the <Tab> 
key to move to the next item. The "0" remains.

Note: Officers signing the report are personally responsible 
for its accuracy. Therefore, it is important that the information 
entered in each item is correct and that zeros only appear 
where appropriate on the signed reports. Do not leave any of 
the Items 24 through 55 blank.

Automatic calculations

The electronic Form LM-3 automatically performs all mathematical calculations required in Item 
24 and Statements A and B.

●     Data entry fields – The fields for the financial items you must complete have blue 
borders.

●     Calculated fields – The fields that are automatically calculated are "display only" fields. 
You cannot change or manually override the calculated value by directly entering a 
different value. Calculated fields have black borders.

When you enter a number for a financial item and press the <Tab> key, the associated 
calculated field displays the new value. For example, when you enter a number in Item 41, 
Interest & Dividends, the system automatically calculates and displays a new number in Item 
44, Total Receipts.
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Financial Items 24 - 55

Completing Item 24

You can either manually enter data in Item 24, All Officers and Disbursements to Officers, or 
import data from a specially formatted text file. See Importing Data into Item 24 in this User 
Guide. 

To manually enter data:

Start in Line 1 of Column A. Enter the last name of the officer and press the <Tab> key to 
move to the first name field. 

Enter the first name. Continue to Columns B through E by pressing the <Tab> key and 
entering the required information. Do not leave a blank in any column. 

For entries in Column C, Status, you can also select from a drop-down list. Click the down 
arrow and select Continuing Officer (C), New Officer (N), or Past Officer (P).

After you complete Column E and press the <Tab> key, the total of Columns D and E for 
the line displays in Column F. The cursor automatically moves to Column A of the next line.
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Financial Items 24 - 55

Continue entering information for all your union’s officers. Remember to enter the names 
of all officers even if your union did not pay them.

If you need to enter information for more than seven officers, click the yellow "Item 24 – 
Continue" button to display a continuation page.

Enter information on the Item 24 continuation page for all remaining officers. Use the scroll 
bar on the right to move up and down the page to view all records. When you have 
entered information for all officers, click the yellow "Return to Item 24" button.

The system displays Item 24 on page 3. The system has calculated the totals for entries on 
the Item 24 continuation page and displays them in Line 8. The totals for Lines 1 through 8 
are displayed in Line 9. Enter the total amount for deductions in Line 10. The system 
calculates the net disbursements displayed in Line 11.

Net disbursements are automatically transferred to Item 45, To Officers, on page 4.
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Financial Items 24 - 55
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Importing Data into Item 24

Importing Data into Item 24

The electronic Form LM-3 gives you the option of importing a database file that you may 
already have into Item 24, All Officers and Disbursements to Officers.

The data you are importing into Item 24 must be in a pipe delimited ascii text file (with a .txt 
extension). Most database programs will export data to a file in this format. 

The fields in your data must be set up as follows:

LastName|FirstName|Title|Status|GrossSalary|Allowances[cr/lf]

where [cr/lf] = carriage return/line feed

Warning: Do not leave any fields blank. In the numeric 
fields such as salary or allowances, enter a zero if there is no 
financial data to report. If you leave any field blank, you may 
not be able to import or the data imported into Item 24 may 
be incorrect.

The system limits the length of each field. Do not exceed the maximum number of characters 
listed below for Item 24 fields:

Field Name No. of 
Characters

Last Name 16

First Name                                                                    10  

Title 19

Status 1

Gross Salary 7

Allowances and Other Disbursements 6

For ease of retrieval, give your file a meaningful name, for example, Item24_import.txt. Your 
file (when opened in an ascii text editor) should resemble the following:

Snyder|Paul|President|C|6000|321[cr/lf]
Polosky|Stella|Vice President|C|200|0[cr/lf]
O'Reilly|Kay|Financial Secretary|P|450|0[cr/lf]
Hirsch|William|Financial Secretary|N|2550|622[cr/lf]
Abraham|Robert|Recording Secretary|C|1000|0[cr/lf]
Linsey|Martin|Trustee|C|200|0[cr/lf]
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Importing Data into Item 24

Warning: Enter pre-fill information and save your form 
before you import data into Item 24. (See Using Pre-Fill 
Data in this User Guide.) Once you complete the import 
function, you will no longer be able to retrieve pre-fill data. 
Also, once you import data into Item 24, you will not be able 
to import data into that item again. Therefore, if there was a 
major problem with the import, close the form without saving 
it. You can work with your information technology team or 
call the OLMS Help Desk at 1-866-319-2675 to help you to 
correct problems in your import data. After you have 
corrected any problems, open your previously saved form 
(which has any pre-fill data you might have used saved in it) 
and try the import again.

To import data into Item 24:

Save your form.

From the "File" menu, select "Import Item 24."

A file box displays. Navigate to the drive and directory where your import data file is 
located and highlight the file name in the list. Click the "Open" button. 
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Importing Data into Item 24

A dialog box displays, reminding you that you can only import into Item 24 one time and 
that once you do you will no longer be able to get pre-fill data, and prompts you to indicate 
that you want to proceed with the import. Click the "Yes" button.

The system imports the data into Item 24. If you have a large amount of data to import 
this can take a few minutes.

If the import is successful, a dialog box displays, telling you that the import process was 
successful and the total number of records imported. Click the "OK" button. 

The Item 24 continuation page displays. The data for the first seven records imported 
display in Item 24 on page 3 and the remaining records display on a continuation page.
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Importing Data into Item 24

Click the yellow "Return to Item 24" button at the top right of the continuation page to 
view the first seven records. Click the yellow "Item 24 – Continue" button at the bottom 
left of Item 24 to return to the Item 24 continuation page to view the remaining records.

Review the data to make sure that it is correct, then save the form.

Note: Once you save the form, you can make changes in the 
fields in Item 24

Checking for errors

If it looks like there was a problem with your import, for example, some data is missing, you 
can check the import log for any entries that were not imported because of formatting errors.

Note: It is a good idea to check the import log as a matter of 
course, particularly if you are importing a large amount of 
data.

To check the import log:

Open Windows Explorer and go to the directory into which you installed the Informed 
program (typically C:\informed). Look for a file named "Item24_import.log."

Open the file using any text editor, such as Windows Notepad. If any records were not 
imported, they will be listed in this file. 

If all the records were imported correctly, this file will be blank.
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Importing Data into Item 24

 

For hints on formatting data in an Excel spreadsheet to insert 
into Item 24, see Importing Data from an Excel Spreadsheet.
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Additional Information - Item 56

Your entries in certain items on the electronic Form LM-3 may require additional information in 
Item 56. 

System Notification

After you make an entry that requires additional information, the system will automatically 
notify you by displaying a dialog box explaining what additional information is needed.

Enter your explanation in the dialog box and click the "OK" button.

Click the "Item 56" tab at the top to display the Item 56 page.

Your explanation is entered on a separate Item 56, Additional Information page which also 
displays your union’s name and file number, the ending date of the period covered by the 
report, and the item number for the additional information. 
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Additional Information - Item 56

Other Item 56 entries

You may also provide additional information directly in Item 56 by clicking the yellow "Click 
to Enter Item 56 Information" button in the Item 56 area of page 1.

The Item 56, Additional Information page displays. Enter the number of the item to which 
the information relates in the Item Number column. Enter "56" in the Item Number column 
to identify additional information not associated with any specific LM-3 item.

Note: Additional information entries do not display or print in 
Item 56 on page 1 of the form. A separate Item 56 page is 
created for each item requiring additional information. For 
example, if you made entries in Item 56 for two items, the 
report will contain two Item 56, Additional Information pages.

To view other Item 56 pages in your report, click the forward or back arrows. Buttons on 
the page also allow you to delete or add an additional information page and return to page 
1 of the form.
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Changing Officers' Titles in Items 57 and 58

When an officer other than the president or treasurer signs the completed Form LM-3, you 
must provide the title of the other officer and explain why the president or treasurer did not 
sign the report.

After completing all other items on the form, click on the title in Item 57 or Item 58. The 
title is highlighted and a drop-down list displays.

If an officer other than the president will sign the report in Item 57 (or other than the 
treasurer in Item 58), click the appropriate title, if available, in the drop-down list to 
display it in Item 57 or 58. 

If the title is not available in the drop-down list, double-click "Other." A dialog box displays 
requesting the appropriate title. Enter the appropriate title in the dialog box and click the 
"OK" button.

The new title displays in the form.

Press the <Tab> key. A dialog box displays requesting an explanation for entry in Item 56, 
Additional Information. Enter your explanation in the dialog box and click the "OK" button.
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Changing Officers' Titles in Items 57 and 58

 

See also Additional Information – Item 56 in this User Guide.
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Checking for Errors - Error Summary

Before signing and submitting your union’s report to OLMS, you must check it for errors or deficiencies 
by running the Error Summary and reviewing the Error Summary results.

To begin, select "Error Summary" from the "File" menu. 

The Error Summary displays in your browser.
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Checking for Errors - Error Summary

Note: The Error Summary lists the LM-3 items which may 
need correction or an explanation in Item 56, Additional 
Information. You can print the summary to use as a reference 
when you return to the Form LM-3 to correct errors. Follow 
your Internet browser’s instructions for printing a copy of the 
Error Summary. 

To return to the Form LM-3, click the "Continue" button at the bottom of the Error Summary screen.

If you are using Netscape, the system closes the browser.

If you are using Internet Explorer, click the "Yes" button in the dialog box to close the browser.

After you have corrected or resolved the errors or deficiencies listed on your Error Summary, run 
the Error Summary again to check that you made all necessary corrections.
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Checking for Errors - Error Summary

If you forget to run the Error Summary and attempt to sign the report by clicking on the "Sign" 
button, the system reminds you to review the LM-3 Error Summary to check for errors on the form 
before applying the digital signature.

To run the Error Summary from this reminder box, click the "Error Summary" button.
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Printing the Form

After you have completed the electronic Form LM-3, run the Error Summary, and corrected any 
errors noted on the Error Summary, you can sign and submit the report electronically. See 
Digital Signatures and Submitting a Form Electronically in this User Guide. Alternatively, you 
can print a paper copy of the form, have your union's president and treasurer sign it manually, 
and mail it to OLMS. Remember to keep a copy of the report for your union’s records whether 
you submit your union’s form by mail or electronically to OLMS. 

Select "Print" from the "File Menu" on the menu bar.

The "Print" dialog box displays. 
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Printing the Form

Note: The print range in the dialog box displays 35 pages, 
the maximum number of pages allowed for the form. When 
you print the Form LM-3 with "all 35 pages" selected, only the 
4-page form; any continuation pages for Item 24, All Officers 
and Disbursements to Officers; and any Item 56, Additional 
Information pages will print.

Click the "OK" button to print the form.

If you have a problem printing the form, consult User Information from the electronic Form LM-
3. Select "User Information" from the "Form Instructions" menu on the menu bar, then select 
"Printer Settings."
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Submitting a Paper Form

As an alternative to electronic submission, you may print the completed Form LM-3 for manual 
signature and submission by mail.

●     Clear the Error Summary message 

After you complete the electronic Form LM-3 but before you print and sign it, you must 
clear the Error Summary message displayed in the signature area of Items 57 and 58 by 
running the Error Summary and making any required corrections.

Note: Your report will not be accepted by OLMS if the Error 
Summary messages in the signature blocks have not been 
cleared.

●     Print the form

When you have cleared the Error Summary message, print a full copy of the Form LM-3 
including Item 56, Additional Information pages. See Printing the Form in this User 
Guide.

●     Sign and date the form

Both the president and treasurer or corresponding principal officers of your 
union must sign the report in Items 57 and 58 in black ink. Original signatures of 
two officers are required on the paper Form LM-3 filed with OLMS; stamped or 
mechanical signatures are not acceptable. 

If officers other than the president or treasurer sign the report, see Changing Officers’ 
Titles in Items 57 and 58 in this User Guide. 

You cannot enter and print dates for signatures on the electronic Form LM-3. Therefore, 
you must manually enter in Items 57 and 58 the dates the report was signed by the 
officers when submitting a paper form. 

●     Forward a form to other persons

If you have e-mail software installed on your computer, you can send your form to other 
persons for review or further processing. See Digital Signatures and Submitting a Form 
Electronically in this User Guide.

●     Mail the form

43



Submitting a Paper Form

Mail the original completed and signed Form LM-3 and any required attachments to:

U.S. Department of Labor
Employment Standards Administration
Office of Labor-Management Standards
200 Constitution Avenue, NW, Room N-5616
Washington, DC 20210
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Digital Signatures and Submitting a Form Electronically

Your union’s president and treasurer must obtain digital signatures and sign reports that you 
submit electronically. Information on obtaining digital signatures and instructions for electronic 
submission of the completed Form LM-3 are available on the OLMS Website at:

http://www.dol.gov/esa/olms_org.htm

As an alternative, you may print the completed Form LM-3 and submit it by mail to OLMS. See 
Submitting a Paper Form in this User Guide. 

Forwarding a form

The electronic Form LM-3 has a built-in feature for sending your form to other persons via e-
mail for review, further processing, or digital signature. 

Before forwarding your form make sure you have saved the most recent version and that it 
is displayed in the active window. Select "Forward" from the "File" menu on the menu bar.

The "Mail System" dialog box displays. Select your e-mail program from the drop-down 
list. Choose "Internet Mail" (SMTP) if your program is not listed.

The "Send" dialog box displays. 
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Digital Signatures and Submitting a Form Electronically

Enter the e-mail addresses of the persons to whom you are sending the form along with 
your message in the appropriate spaces and click the "Send" button.

Note: Persons receiving your form must have the electronic 
Form LM-3 and Informed Filler installed on their computers to 
view, edit, or apply digital signatures to the form.
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Getting Help

You can get help in completing the electronic Form LM-3 from a number of sources.

Form instructions

You can access a full set of the Instructions for Form LM-3, which give item-by-item guidance 
for completing the form, directly from the electronic Form LM-3. 

Start the electronic Form LM-3 and select "LM-3 Instructions" from the "Form Instructions" 
menu on the menu bar.

The Instructions for Form LM-3 display in your browser. Scroll down to the Table of 
Contents and select the appropriate topic or item. 

User information

You can access information on the electronic form operation directly from the electronic Form 
LM-3. Topics discussed include system requirements, printer settings, digital signatures, 
electronic submission, navigation, import procedures, pre-fill data, and OLMS Help Desk 
information. 

Start the electronic Form LM-3 and select "User Information" from the "Form Instructions" 
menu on the menu bar.

User Information displays in your browser. Select the appropriate topic or item in the Table 
of Contents. 

Informed Filler 

You can access information on Shana’s Informed Filler program operation directly from the 
electronic Form LM-3. 

Start the electronic Form LM-3 and select "Contents" from the "Help" menu on the menu 
bar.
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Getting Help

A list of available topics displays.

OLMS Help Desk

If you have problems using the electronic Form LM-3 which you are unable to solve with the 
information in this User Guide or the above sources, contact the OLMS Help Desk at 1-866-319-
2675.

OLMS field offices

If you have questions about completing items on the Form LM-3 or other reporting questions, 
contact the nearest OLMS field office. You can access the list of OLMS field offices within the 
electronic Form LM-3 by selecting "LM-3 Instructions" from the "Form Instructions" menu on 
the menu bar and then selecting "If You Need Assistance" from the Table of Contents.

Addresses and telephone numbers of OLMS field offices are also on the OLMS Website at:

http://www.dol.gov/esa/olms_org.htm
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Appendix 1 - Importing Data from an Excel Spreadsheet

The following instructions tell you how to format data from an Excel spreadsheet to import into Item 
24 on the electronic Form LM-3. If you use a different spreadsheet program the steps you take will be 
similar to the ones below.

In Excel, strip out all headings and totals so that all you have on your worksheet is the raw data 
in the appropriate format. Be sure to refer to the Instructions for Form LM-3 to ensure that the 
data to be imported will accurately report the required information.

From the "File" menu, select "Save As."

In the "Save as type" drop-down list, select "Text (tab delimited)."
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Importing Data from an Excel Spreadsheet

Click the "Save" button.

Note: Remember the name of your file and where it is saved 
on your system.

Once you have saved your file in a tab delimited format you need to open the file in a word processor 
or text editor and replace the tabs with pipe ("|") symbols.

Follow the instructions below if you are using Microsoft Word as your word processor. If you use 
another word processor, the steps may differ but the procedure will be similar.

Open Microsoft Word.

From the "File" menu, select "Open."

Navigate to the drive and directory where you have saved your text file. From the "Files of type" 
drop-down list, select "All Files." 
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Importing Data from an Excel Spreadsheet

Select the text file you created and click the "Open" button.

Your document should look something like this:

From the "Edit" menu, select "Replace." The Find and Replace dialog box displays.

In the "Find what:" field enter ^t (the carat symbol which is <Shift> 6 on your keyboard and a 
lowercase "t") . This is Microsoft Word’s code for a tab.

●     In the "Replace with:" field enter | (the pipe symbol, which is located below the <Backspace> 
key on your keyboard).
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Importing Data from an Excel Spreadsheet

●     Click the "Replace All" button. The system displays a message indicating the number of 
replacements made.

Save your file.

You are now ready to import the data following the instructions in the User Guide for the form you are 
completing.
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